DLA
FedMall Quick Start Guide

Supplier Catalog Template

Version 1.0

Document Date: August 14, 2018



Supplier Catalog Template

Document History

Revision History

Revision Number

Revision Date

0.0.1
0.1.2

0.1.7
0.1.8
0.2.0

1.0

3/14/2016
6/28/2016

1/24/2017

2/2/2017

2/14/2017
5/02/2017
6/13/2017

7/11/2017
2/05/2018

8/14/2018

Summary of Changes Author
Initial draft Don Tennant
Minor revision. Incremented the version number to remain in Don Tennant

sync with referenced spreadsheet version. Described how to

specify a contract ID for MarketPlace catalogs. Listed reference

location for MRC code lookup (new section 2.4).

Minor revision. Provided additional clarification about how to Don Tennant
manage the data formats when using Microsoft Excel to edit

the template; added a new section 2.5 and updated the notes

for the two date fields in section 3 “Field Descriptions.”

Inserted new section 2.7 to clarify the use of delimiters with Don Tennant
optional fields. Expanded section 2.8 to include sample

records. In section 3, clarified that the "Justifying Comment"

fields are conditionally required. Updated URL in section 4.2,

and clarified the origin of the note in section 4.3.

Marked Quantity Per Unit Pack and Days ARO as mandatory Don Tennant
fields.

Added information about handling numeric content as text Don Tennant
when viewing the catalog in Microsoft Excel to section 2.5.

Removed outdated URL from section 2.4. Don Tennant
Clarified allowable characters in Section 3 Don Tennant
Added information related to additional supported file formats Eric Abe,
(Excel .xIs and .xIsx files). Additional section to detail allowed Shanzeh
values in the General Text field. Hammed
Clarified the maximum file size for uploads (section 2.2). Don Tennant

FedMall QSG Catalog Template v1.0.docx

Status: Review
Page 2 of 27



Supplier Catalog Template

Contents
(Do Yol U] 0 aY=T o I ll = TS5 10 2
AV [o] o W o 11 o o AT TP PPRORPPPPPTN 2
(670] 01T o1 £ LTS U PP OPPIPP 3
N [ 4 o Yo [V £ o] o F O PR PP P PPPRUPPPTRROPPPPOR 4
11 U] oTo L= U UUTPTP 4
1.2 FY U T [T Tl TPV PRURPOPRP 4
1.3 DOCUMENT REFEIENCES....ciiiiiiiitiiietit ettt sttt b e b sa e et e b s bbb e s b e e b e b e enesbe e b e nes 4
P 111 { ¥ o o o O U RN 5
2.1 SUMMATY Of PrOCEAUIE ...cviiieiiii ettt ettt e et e ettt e et te e e s beee e ateeaestaeessabeeeasbaeaassseeeasbeeesbaeeaassseeassseessbaeensssaeansnen 5
2.2 (07 ) =1 o= S 1T D= - Y| LR PP SRUPRRPPPPRIRt 5
23 IMIANAGING IMAEES ..eeeeeeieiiieiee ettt ettt e e e e e st e e e e e ettt ee e e e e ane et ee e e s e a e s e e e e e e e e nseeeeeee s anbaeeeeesaaassseeeeeesannsneeeeesannnrnenen 5
2.4 Using MRCs to Specify Additional CharaCteriStiCS........cuirieiriereeeseerireieeseesteeseesee e rte e s e e teeseeesseeesseesneeesseesnseenseessees 5
2.5 Formatting instructions for creating a .XIs or .XISX fil@ ......ccccuiiiiiiiiiiiiicce e et 6
2.6 Formatting instructions for Creating @ .CSV fil.. ..t e e et be e e e bae e e aaeeas 6
2.6.1 Managing Number and Date FOrmMats iN EXCEl ......cccuviiuieeiieeieeie ettt se e e e eeste e see et e s seeese e s e enseesseesnseenneeenes 6
2.6.2 EXPOrting @ TeXt File frOM EXCEI .....oiveieeieeie ettt et te et e st e et e st e e ae e st e e nte e saeenseenseesneeenneesneeenseas 8
2.6.3 Maintaining Delimiters With Optional FIelds ...........oiiiiiiiiiiiii st bee e et e e aa e e sbaeeesnteeaennne 9
2.6.4 [T 1 4] o] LTSRN 10
I S 1= [ WD T ol g1 o1 4[] o PP UPPRPRRN 11
3.1 T = PP P PPN 11
3.2 = Lo [PPSR P PR PROPPPTP 11
4 Additional Information: X12 COOES .......uuiriiiiiiiiiiieeiie ettt saee e 15
4.1 L0 A =T QYT OO 15
4.2 T =P P TP 15
4.3 (00T =TT OO T OO TP TP P UPPPPPRO 15
5 Additional Information: General TeXt.......cueeviiiriiiirieieie e 27
5.1 (O AT YT PPRN 27
5.2 Permitted CharaCers ........oo ittt s e s bt e s me e e b e e s ae e e bt e saresaneeeneeeneenaneans 27
53 PrORIDITEA CRAIACEIS ...ttt ettt et s bt et e b e e st e be s st e e e e ae et e nbeemee bt easenbesaeebesbeennenee 27
FedMall QSG Catalog Template v1.0.docx Status: Review

Page 3 of 27
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1. Introduction

1.1 Purpose

The purpose of this document is to assist suppliers with the generation of a valid Excel spreadsheet to create or maintain
their catalog items in FedMall.

1.2 Audience

The intended audience of this planning document is:
U FedMall Suppliers
U FedMall Program Managers

W Communication Leads

1.3 Document References

This document is based on the following documents:

Document Name Version Owner

FedMall Supplier Catalog Template Spreadsheet V0.1.8 IBM

Status: Review
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2 Instructions

2.1 Summary of Procedure

e Complete the “Catalog Template” sheet with your catalog details. Do not modify the number or the order of
the columns.

e Reference the “Field Descriptions” sheet and the “Additional Information” sheet for help on completing the
data entry. You may leave optional fields blank.

e If the item already exists in FedMall, it will be overwritten. If it does not already exist in FedMall, it will be
added. To delete an item, enter a “Y” in the first column (Archive); otherwise, leave the first column blank (or
specify “N” in the first column).

e  When complete, upload the file to FedMall via the Supplier Portal.

2.2 Catalog File Details
File Type The file must be one of the following formats:

(1) Plain text file with a .csv extension
(2) Excel file (97-2003 format) with a .xIs extension
(3) Excel file with a .xlIsx extension

Row Header Use the headings on the “Catalog Template” sheet. The uploaded file must include the headings as its first
row.
Field Delimiter If creating a plain text .csv file, each field should be separated from adjacent fields with a delimiter, which is

the caret ( » ) character. If you want to use Microsoft Excel to create your data file and then export it to
delimited plain text file, instructions are provided below in section 2.5.

Rows You may insert as many rows of data as will fit in the maximum file size (see below). This will typically be
around 100,000 rows of data per uploaded file.

File Size The size of the file will vary not only with the number of rows of data, but also with the content of each row.
The file may not exceed a maximum size of 63 million bytes (about 60 Megabytes).

File Name The file name must be less than 128 characters and cannot contain a caret ( * ) character.

2.3 Managing Images

All images are uploaded in an archive (.zip) file separate from the main catalog spreadsheet. Please see the “Image
Upload Specification” document for complete details about how to structure that image file archive.

2.4 Using MRCs to Specify Additional Characteristics

The final field in the template, “Characteristic Information,” represents a series of code-value pairs, where the code is a
Master Requirements Code (MRC) as listed in the Master Requirements Directory (MRD), which in turn is managed by
the Defense Logistics Agency (DLA) Logistics Information Services (DLIS).

If you don’t already know a specific MRC code, you may search for individual codes in the Supplier Portal by accessing
Product Information Management and adding/editing an item.

FedMall QSG Catalog Template v1.0.docx Status: Review
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2.5 Formatting instructions for creating a .xls or .xlsx file

If you are creating a .xls or .xlsx file, the worksheet containing the catalog data must be the first sheet in the spreadsheet. When
uploading .xls or .xIsx files, all worksheets within the file are ignored except for the first worksheet.

If necessary, you can move the catalog data worksheet by simply dragging the worksheet tab to the front of the other worksheet
tabs contained within your spreadsheet.

2.6 Formatting instructions for creating a .csv file

If you are creating a .csv data file, special care needs to be taken to ensure that the proper formatting is used in the data file. Please
see the following sections for details on this formatting.

2.6.1 Managing Number and Date Formats in Excel

If you are using Microsoft Excel to edit your data file (.csv), Excel may try to automatically convert the format of your numbers and
dates from the required format. Examples include:

e Long numbers: If you enter a very long value, such as a part number, that only contains the digits 0-9, Excel may try to
interpret this as a long number and display it in scientific notation (e.g. “1234567890123” would display as
“1.23457E+12").

e Dates: If you enter a value that Excel believes is a date, it will attempt to convert the value to its own format (e.g. “2017-
01-24”, which is in the correct format, may be changed to “1/24/17” by Excel).

e Values with a leading zero: Excel will recognize that a CAGE code or part number with letters in it is text, e.g. “012AB”;
however, if the value is all-numeric and starts with a zero, Excel will treat it as a number and trim the leading zero (e.g.
“02468" is converted to “2468").

Essentially, in all of these examples, Excel is attempting to format your data for you, when you want the data to be stored exactly as
you enter it.

2.6.1.1 First step: Understand the format that is actually saved in your file

If you have an existing .csv file, the way to ensure that you understand what is actually in that file is to open it in a plain text editor,
such as Notepad, rather than in Excel. To do this, you may choose one of these options:

e  Open Notepad (from the Start menu), then select File -> Open, and open the .csv file.
e  From Windows Explorer, right-click the file, select “Open With...” and then choose Notepad (or another text editor, such
as Notepad++).

85 |8/2017 1137 PM_ Microsoft Excel C... 1KB
= Open i

Print
[ Edit with Notepad++

Scan for Viruses... 1

Open with 3 Excel 2016

Publish into Privia... __—l Notepad
[.__‘_‘1" MNotepad++ : a free (GNU) source code editor

Restore previous versions f-l OpenQiffice Calc

Send to t Choose default program...

Symantec Encryption Desktop 3 j’

2.6.1.2 Entering new data into a template

If you are creating a new catalog from scratch, you will want to start with a template. FedMall provides a sample template in
addition to this Quick Start Guide. Before entering data into a blank cell, ensure that the format is correctly set to “Text.” Change
the format of the cell(s) in question to “Text” instead of “General” or “Date.” You may do this globally for all cells in the template
you are working with. (Hint: to select all cells at once, click any cell, and then tap Ctrl-A on your keyboard.)

FedMall QSG Catalog Template v1.0.docx Status: Review
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2.6.1.3 Working with an existing file

If you already have a .csv file and you open it in Excel, you may notice that Excel converts the values to their numeric and date
formats automatically. This may happen when you open the .csv file: (1) from Excel’s File -> Open menu, or (2) by double-clicking on

the .csv file in Windows Explorer to open it in Excel.

To avoid this issue, you may want to import the data when you open the file, rather than opening it directly. To do this, open Excel
to a blank workbook. Before you import your data, set all fields in the worksheet to Text (as described in section 2.6.1.2), and select

the “Get Data from Text” option from the Data tab.

Formulas

Home Insert Page Layout
’—‘—\ Iy D I—‘A F [T Show Queries ||= 2
3
'@ [ _D -¢’- o E‘ D Fram Table o
From Frd Fram Frgm Other Existing New Refresh
Access Weby | Text Aources~ Connections  Query~ [:'_‘ Recent Sources All~
el External Data Get & Transfarm Conn|
Al Get Data From Text
Import data from a text file,
A B C D E E G
1 ' |
]

Select your .csv file in the Open dialog box, and then proceed through the steps of the Text Import Wizard. In Step 1, choose
“Delimited” and select the check box next to “My data has headers.”

Criginal data type

@ Delimited

Start import at row: |1 _: |

File origin:

The Text Wizard has determined that your data is Fixed Width.
| If this is correct, choose Mext, or choose the data type that best describes your data, H

Choose the file type that best describes your data:
- Characters such as commas or tabs separate each field.

(7 Fixed width - Fields are aligned in columns with spaces between each field.

437; OEM United States

Preview of file C\don\DLATraining\Quick Start Gui.. \QSG_Sample_20170131_Zrecords_UTF-8.csv.

1
2]

4]
=]
4

ftem Master Primary Spec/Item Status Informatiocn/Archive Item Master Pri
~0Z188"MARKETPLACE 0Z188-PN12345-5tamp, & Digit Numbr Pro~7510-20.83-EA-| |
~0Z188-MARKETPLACE 0Z188~1Z3RBC45-Label, Heat Shrink, 1/4—inch, White~75

(e ) (g ]

-

+
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In Step 2, specify that the delimiter is a caret ( ~ ) by checking the “Other” box and typing a caret in the blank field.

—— Bl
Text Import Wizard - Sten 2 of - [

This screen lets you set the delimiters your data contains, You can see how your text is affected in the
preview below,

Delimiters
[F] 7ab
iil Semicolon 'j Treat consecutive delimiters as one
E, Comma

) Text qualifier: |~ -
[7] space D
-!' Diher.. |~

Data preview

tem Master Primsry Spec/Item Status Information/Archive [[tem Master Primar| +
Z1e8
Zls88

3

‘ Cancel ][ < Back || Mext > |{ Finish ]

In Step 3, you may leave the default settings (“General”) for most fields, because you already set all fields to “Text” before you
started the import wizard. However, Excel will still try to convert the date formats, so be explicit for the Sale Start Date and Sale End
Date by selecting each of those columns in turn and choosing “Text” from the list of column data formats.

This screen lets you select each column and set the Data Format.

Column data format

General -
‘General converts numeric values to numbers, date values to dates, and
all remaining values to text,

Date: WMDY |z| Advanced...

(") Do not import column {skip)

Data preview

Les
pERCNT tem Master Primary S5

017-09-30

| Cancel ] < Back Mext = | Einish |

In the final step, you will be able to select where the imported data should go (e.g. cell Al of your current, blank spreadsheet).

Your imported data will now be presented as all text values.

2.6.2 Exporting a Text File from Excel

You may create your catalog file in any text editor. You may also find it convenient to use Excel to maintain your data and then
export the data from Excel to the delimited text file for import into FedMall.
e First, change your delimiter (“list separator”). Open Control Panel and then the “Region and Language” applet (or, click

Start -> Run and type “intl.cpl”). On the Formats tab, click “Additional settings...”. Change the “List separator” value from
its default (usually a comma) to the caret (Shift + 6 on most US keyboards). Click OK to save the change.

Status: Review
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“# Region and Language

Formats | Location I Keyboards and Languages | Administrative 1

‘) Customize Format

Format:

[English (United States)

Date and time formats

Short date: [Mrdryyyy -
Long date: [dadd, MMMM dd, yyyy -
Short time: [himm -
Long time: [hemmm:ss it -
First day of week | Sunday -

What does the notation mean?

Examples

Short date: 3/14/2016

Leng date: Meonday, March 14, 2016
Shorttime: 11:21 PM

Leng time: 11:21:12 PM

Go online to learn about changing languages and r

Additional settings... |

gional Tormats

o) Com ]

habers | e
Example
Positive:  123,456,783.00 Negative:  -123,456,789.00
Decimal symbol: -
Ne. of digits after decimal: [2 vl
Digit grouping symbeol: i >
it (123,456,720 -
MNegative sign symbol: - -
MNegative number format: [-l.l ']
Display leading zeros: [0,? VI
’ List separator: - - l
Measurement system: [ Us. V]
Standard digits: [0123455789 ']
Use native digits: lNever ']
Click Reset to restare the system default settings for IE|
numbers, currency, time, and date.

[ e

H Cancel H

e In Excel, create your catalog. Ensure that the first row contains the column headers as listed in the “Catalog Template”
sheet. Click File -> Save As. In Save As Type, select “CSV (Comma delimited) (*.csv)”. Provide a file name and click Save.
Excel will warn you that “some features in your workbook might be lost”; click Yes to keep using this format (Excel is
warning you that some features, like formatting, won’t be saved in a text file; this is to be expected).

e Confirm a successful export by opening the file in a plain text editor (such as Notepad). You should see the header row on
the first line followed by your data, with a caret ( A ) character separating each data field (“column”).

2.6.3

Maintaining Delimiters with Optional Fields

There must be a caret separating each field, even if an optional field is left blank. For example, if leaving OEM CAGE Code blank

(between OEM Part Number and OEM Name), the fields might look like this:
LLAPN123457"Company Name”...

This same principle holds true at the end of the row. For example, if you leave the last five fields blank in a given row, that row

would end with five carets (M A7), like this:

.."This item meets environmental regulations

AAAAAN

FedMall QSG Catalog Template v1.0.docx

Status: Review
Page 9 of 27



Supplier Catalog Template

2.6.4 Example

The first row of your .csv text file is a header row, and it should look like this:

Item Master Primary Spec/Item Status Information/Archive®ltem Master Primary Spec/Common
Information/Commercial and Government Entity Code*ltem Master Primary Spec/Common Information/Contract
Number~ltem Master Primary Spec/Common Information/Part Number*ltem Master Primary Spec/Common
Information/Part Name”ltem Master Primary Spec/Common Information/Federal Supply Class*ltem Master Primary
Spec/Pricing/Original Unit PriceAltem Master Primary Spec/Pricing/Original Unit of Issue*ltem Master Primary
Spec/Pricing/Quantity Per Unit Pack”*ltem Master Primary Spec/Common Information/Original Equipment
Manufacturer Part Number”ltem Master Primary Spec/Common Information/Original Equipment Manufacturer CAGE
Code*ltem Master Primary Spec/Common Information/Original Equipment Manufacturer Name”*ltem Master Primary
Spec/Short Description*ltem Master Primary Spec/Common Information/Days After Receipt of Order*ltem Master
Primary Spec/Long Description®ltem Master Primary Spec/Common Information/Universal Product Code”ltem Master
Primary Spec/Commercial Information/Environmental Information/Hazardous Material Flaghltem Master Primary
Spec/Sale Pricing/Sale Start Date*ltem Master Primary Spec/Sale Pricing/Sale End Date”ltem Master Primary Spec/Sale
Pricing/Sale Price*ltem Master Primary Spec/Commercial Information/Shipping Information/Shipment Level of
Service/Standard Shipment PriceAltem Master Primary Spec/Commercial Information/Shipping Information/Shipment
Level of Service/Expedited Shipment Pricerltem Master Primary Spec/Commercial Information/Shipping
Information/Shipment Level of Service/Next Day Shipment Price*ltem Master Primary Spec/Special
Properties/Environmentally Preferred/Environmentally Preferred Indicator?ltem Master Primary Spec/Special
Properties/Environmentally Preferred/Justifying Comment*ltem Master Primary Spec/Special Properties/Energy
Star/Energy Star Indicator®ltem Master Primary Spec/Special Properties/Energy Star/Justifying Comment”ltem Master
Primary Spec/Special Properties/Made in the USA/Made in the USA Indicator*ltem Master Primary Spec/Special
Properties/Made in the USA/Justifying CommentAltem Master Primary Spec/Characteristic Information

After including the header row on line 1 of your file, include one item record on each subsequent line (beginning with line 2) of the
file. The following text represents two well-formed records that will pass file upload validations (although of course the CAGE code
and contract number are fictitious). The first sample record only includes the mandatory fields; the second record has all fields
completed.

NAAB123AMARKETPLACE_AB123”PN12345AStamp, 6 Digit Numbr ProA7510720.83"EAM1AUSST554672U. S. STAMP &
SIGN~Professional Numberer, Self-Inking, Type Size 1 1/2, Six Digits, Black?2”Strong and fast to tackle even the biggest
numbering jobs. Steel frame construction stands up to heavy-duty use. A self-inking pad saves time; there's no need to
stop and re-ink. Includes replaceable stamp pad that delivers up to 10,000 impressions. Stamp Type: Numberer; Ink
Types: Self-Inking; Impression Width: 1 5/8 inch; Impression Height: 3/8 inch. AMAAAAAAANAANA

NAAB123A*MARKETPLACE_AB12372123ABC45”Label, Heat Shrink, 1/4-inch,
White”r7510735.57ARO*1"DYM18051"A1B2CASANFORD LP”Rhino Heat Shrink Tubes Industrial Label Tape Cassette,
1/4 IN X 5 FT, White*1~Durable and smear-proof. Resistant to chemicals, solvents, grease, heat, moisture and other
harsh elements. Industrial-strength adhesive for labels that stick and stay stuck. Easy-to-peel split backing for simple
application. Label Size - text: 1/4 in x 5 ft.; Label Color(s): White; Machine Compatibility: Label Makers; Printed Text
Color(s): Black.A71701180513~N”2017-01-0122017-09-30729.82/4.99719.99214.99 Y AThis item is Green
Certified2Y~This item received Energy Star Certification in 20172YAManufactured in California with materials sourced
from Maryland*AAAB | white~~~~~ CGCY | Office supplies~~~~~ ABGL|0.25 inches~~~~ ASHR | Varies

FedMall QSG Catalog Template v1.0.docx Status: Review
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3 Field Descriptions

The following table provides descriptions of columns in the Supplier Catalog Template.

3.1 Notes

= Under Req? (i.e. Required?), options are:
o N: No, not required. If this optional field isn’t included, you will still need to include the delimiter ( A ) between fields.
o Y: Yes, required field. Must be included for each row.
o C: Conditionally required field. Must be included if another field is provided; see the field description for more

information.

= Do notinclude acarat (") ora pipe ( | ) within any field (e.g. within a description) in the file, except as a
delimiter as specified in this document.

= Note that the Characteristic Information field (the very last field) may include more than one characteristics
within the single field. See the field description for details about how to separate the characteristic (MRC
Code) from its value for each characteristic.

= Because this is a text file, all values (including numbers) are stored as text. If using a spreadsheet to capture

this data, ensure that you are setting the format of all fields as “text.”

= Ensure that no fields include non-printable characters or any white space other than a standard space. In

particular, do not include carriage returns or line feeds within the description fields.

3.2 Fields

Field Name

Position

Field Description

Format

Attribute Header (matches
the column headers in the

“Catalog Template” sheet)

Archive 1 This field indicates whether the item 1 letter 1 Item Master Primary
should be marked for deletion (archive). {Y, N} Spec/Item Status
Valid values are “Y” (yes, archive; mark Information/Archive
as deleted in the database) or “N” (no,
default).
Commercial and 2 The CAGE code of the supplier; a 5- Exactly 5 uppercase 5 Item Master Primary
Government character alphanumeric code issued by letters and/or Spec/Common
Entity Code the US Government numbers Information/Commercial
{A-Z, 0-9} and Government Entity
Code
Contract 3 The full contract number associated with  Uppercase letters 20 Item Master Primary
Number this item’s catalog. For MarketPlace and/or numbers; Spec/Common
catalogs without a contract, use the underscore is Information/Contract
identifier MARKETPLACE_<CAGE>. That allowed for Number
is, a single underscore character ( _) MarketPlace. No
separates the all-capital word hyphens.
“MARKETPLACE” from the supplier’s {A-Z,0-9, _}
CAGE code (5 alphanumeric characters).
Example: MARKETPLACE_012AB.
Part Number 4 Your part number; the part number as Letters and/or 80 Item Master Primary
captured by the vendor/supplier. numbers and/or Spec/Common
Note: Part Numbers must be unique hyphen. Information/Part Number
throughout the file and should not be {A-Z, a-z, 0-9, -}
duplicated within the same file.
Part Name 5 Product name; the name of the item General text; do not 80 Item Master Primary
use caret ( ~ ) or pipe Spec/Common
(1) Information/Part Name

FedMall QSG Catalog Template v1.0.docx
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Position

Field Name

Field Description

Attribute Header (matches
the column headers in the

“Catalog Template” sheet)

point the sale price will be effective. Use
format YYYY-MM-DD, e.g. 2015-12-17.
Note: If using Microsoft Excel to create a
.csv file , change the format to “Text”
(instead of “Date” or “General”) to
prevent Excel from converting the
numbers into its own data format.

hyphens only.
{0-9,-}

Product Service 6 The PSC (product service code) includes Exactly 4 uppercase 4 Item Master Primary

Code all of the Federal Service Code (FSC) letters and/or Spec/Common
numbers and includes additional codes; numbers Information/Federal Supply
PSCs are 4 alphanumeric characters {A-Z, 0-9} Class
long.

Price 7 This is the customer cost; note: for FOB Numbers and 20 Item Master Primary
Destination, this price must include the decimal point (no Spec/Pricing/Original Unit
shipment costs. Enter the price as a commas or dollar Price
number with up to two decimal digits; sign).
do not include the dollar sign. {0-9, .}

Unit of Issue 8 This is a word such as “each,” “box,” or Uppercase letters 2 Item Master Primary
“carton,” to describe the unit associated and/or numbers Spec/Pricing/Original Unit
with the quantity. Use a valid code from {A-Z, 0-9} of Issue
the list provided in the next sheet.

Quantity per 9 Also known as the quantity per unit of Whole number 20 Item Master Primary

Unit Pack issue; this is the number of items in each ~ {0-9} Spec/Pricing/Quantity Per
box, carton, etc. Unit Pack

OEM Part 10 The original equipment manufacturer General text; do not 80 Item Master Primary

Number (OEM) part number; do not modify with use caret ( *) or pipe Spec/Common
a prefix or suffix (1) Information/Original

Equipment Manufacturer
Part Number

OEM CAGE Code 11 The original equipment manufacturer Exactly 5 uppercase 5 Item Master Primary
(OEM)’s 5-character Commercial and letters and/or Spec/Common
Government Entity (CAGE) code numbers Information/Original

{A-Z, 0-9} Equipment Manufacturer
CAGE Code

OEM Name 12 The original equipment manufacturer General text; do not 80 Item Master Primary
(OEM) name; the name of the company use caret () or pipe Spec/Common
that manufactured the item (1) Information/Original

Equipment Manufacturer
Name

Description 13 Detailed description of the item (spell General text; do not 254 Item Master Primary

out key words) use caret (A ) or pipe Spec/Short Description
(1)

Days ARO 14 Time frame from receipt of order (ARO = Whole number 20 Item Master Primary
After Receipt of Order) to shipping; this {0-9} Spec/Common
is not the same as the time frame for the Information/Days After
delivery of an order. Receipt of Order

Expanded 15 Long description of the item. General text; do not 3000 Item Master Primary

Description use caret ( ~ ) or pipe Spec/Long Description

(1)

UPC 16 The universal product code (“bar code”) Numerals only (do 12 Item Master Primary
number. Use only digits 0 through 9; do not use hyphens). Spec/Common
not include the hyphen (-) character. {0-9} Information/Universal

Product Code

Hazardous 17 Indicates hazardous material (HAZMAT) 1 letter 1 Item Master Primary

Material Flag classification. Valid values are “Y” (yes, {Y, N} Spec/Commercial
HAZMAT) or “N” (no). Information/Environmental

Information/Hazardous
Material Flag
Sale Start Date 18 The date (date only, no time) at which Numerals and 10 Item Master Primary

Spec/Sale Pricing/Sale Start
Date
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Position

Field Name

Field Description

Req
?

Attribute Header (matches
the column headers in the

“Catalog Template” sheet)

Shipment Price

two digits after the decimal; do not
include the dollar sign.

decimal point (no
commas or dollar

Sale End Date 19 The date (date only, no time) at which Numerals and 10 Item Master Primary
point the sale price will no longer be hyphens only. Spec/Sale Pricing/Sale End
effective. Use format YYYY-MM-DD, e.g. {0-9, -} Date
2015-12-17. Note: If using Microsoft
Excel to create a .csv file, change the
format to “Text” (instead of “Date” or
“General”) to prevent Excel from
converting the numbers into its own
data format.

Sale Price 20 Enter the price as a number with up to Numbers and 20 Item Master Primary
two decimal digits; do not include the decimal point (no Spec/Sale Pricing/Sale Price
dollar sign. commas or dollar

sign).
{0-9, .}
Standard 21 Enter the price as a number with up to Numbers and 10 Item Master Primary

Spec/Commercial
Information/Shipping

Shipment Price

two digits after the decimal; do not
include the dollar sign.

decimal point (no
commas or dollar

sign). Information/Shipment Level
{0-9, .} of Service/Standard
Shipment Price
Expedited 22 Enter the price as a number with up to Numbers and 10 Item Master Primary

Spec/Commercial
Information/Shipping

Shipment Price

two digits after the decimal; do not
include the dollar sign.

decimal point (no
commas or dollar

sign). Information/Shipment Level
{0-9, .} of Service/Expedited
Shipment Price
Next Day 23 Enter the price as a number with up to Numbers and 10 Item Master Primary

Spec/Commercial
Information/Shipping

sign). Information/Shipment Level
{0-9, .} of Service/Next Day
Shipment Price
Environmentally 24 Indicates whether this item is 1 letter 1 Item Master Primary
Preferred environmentally preferred. Valid values {Y, N} Spec/Special
Indicator are “Y” (yes) or “N” (no). Properties/Environmentally

Preferred/Environmentally
Preferred Indicator

Environmentally 25 Free text comments to justify the General text; do not 3000 C Item Master Primary

Preferred indicator. Required only if the associated  use caret () or pipe Spec/Special

Justifying indicator is “Y”; otherwise, leave blank. (1) Properties/Environmentally

Comment Preferred/Justifying
Comment

Energy Star 26 Indicates whether this item is Energy 1 letter 1 Item Master Primary

Indicator Star certified. Valid values are “Y” (yes) {Y, N} Spec/Special

or “N” (no). Properties/Energy

Star/Energy Star Indicator

Energy Star 27 Free text comments to justify the General text; do not 3000 C Item Master Primary

Justifying indicator. Required only if the associated  use caret () or pipe Spec/Special

Comment indicator is “Y”; otherwise, leave blank. (1) Properties/Energy
Star/Justifying Comment

Made in the USA 28 Indicates whether this item is made in 1 letter 1 Item Master Primary

Indicator the USA. Valid values are “Y” (yes) or {Y, N} Spec/Special

“N” (no). Properties/Made in the

USA/Made in the USA
Indicator

Made in the USA 29 Free text comments to justify the General text; do not 3000 C Item Master Primary

Justifying indicator. Required only if the associated  use caret () or pipe Spec/Special

Comment indicator is “Y”; otherwise, leave blank. (1) Properties/Made in the
USA/Justifying Comment
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Field Name foster  Field Description Attribute Header (matches

the column headers in the
“Catalog Template” sheet)

Characteristic 30 List of Master Requirement Codes Code: 4 uppercase 13595 Item Master Primary
Information (MRC). Format string as one or more letters. {A-Z} Spec/Characteristic

code-value pairs. Separate the code Value: General text; Information

from its value with the pipe (]) do not use caret (")

character. Separate each code-value pair  or pipe ( | ).

with five (5) tilde characters (~~~~~ ).

Format is:

codel|valuel~~~~~code2|value2~~~~~

code3|value3~~~~~code4|value4. Do
not use the delimiters (i.e. the pipe
character or five consecutive tildes) in
either the codes or the values provided.
A maximum of 100 code-value pairs may
be included per item.
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4 Additional Information: X12 Codes

4.1 Overview

FedMall uses X12 codes on all outbound requisitions and purchase orders. For those vendors who are using the DoD codes, please
use the conversions available in the table below. All codes in vendor catalog uploads should be X12 codes as listed below.

4.2 Notes
Number of codes: 485

Reference URL: http://www.dImso.dla.mil/eApplications/LogDataAdmin/dlmsansiconverguides.asp

4.3 Codes

Notes:  The following note is provided verbatim from the source document on the DLA.mil site:
ALL X12 CODE VALUES WITHOUT TRAILING ASTERISKS (*) HAVE BEEN APPROVED BY THE ASC X12 COMMITTEE FOR USE IN
ALL VERSION RELEASES OF ANSI X12. A SINGLE ASTERISK (*) INDICATES THAT X12 CODE VALUES ARE AUTHORIZED FOR USE
IN VERSION RELEASES 005020 AND AN ALL SUBSEQUENT VERSIONS. THE X12 CODE VALUES FOLLOWED BY A DOUBLE
ASTERISK (**) HAVE BEEN APPROVED FOR VERSION RELEASE 005030 AND ALL SUBSEQUENT VERSIONS.

DOD CODE NAME/DEFINITION X12 CODE
(for reference only) (to be used in FedMall)

SC SECOND 3
LIFT 5
STRAND 7
9 TIRE 9

GP GROUP 10

oT OUTFIT 11

Pz PACKET 12

RA RATION 13

SO SHOT 14

SX STICK 15

17 100 POUND DRUM 17

18 55 GALLON DRUM 18

19 TANK TRUCK 19

IN COUNT IN

10 SEASON 10

1P TANK CAR 1P

FR FRAME 1Q

1R TRANSACTION 1R

1X QUARTER MILE 1X

20 20 FOOT CONTAINER 20

21 40 FOOT CONTAINER 21

2D SHIP SET 2D
MB BRITISH THERMAL UNITS/HOUR 2|
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DB DECIBEL 2N

KC KILOCURIE 2R

2U MEGAGRAM 2U

2W BIN 2W

43 SUPER BULK BAG (SAME SIZE AS PALLET) 43

44 500 KILOGRAM BULK BAG 44

45 300 KILOGRAM BULK BAG 45

46 25 KILOGRAM BULK BAG 46

47 50 POUND BAG 47

48 BULK CAR LOAD 48

4A BOBBIN 4A

4B CAP 4B

4E 20-PACK 4E

4F 100-PACK 4F

4G MICROLITER 4G

51 ACTUAL TONNES 51

57 MESH 57

58 NET KILOGRAMS 58

5B BATCH 5B

5D PROOF GALLONS 5D

5G PUMP 5G

5H STAGE 5H

51 STANDARD CUBE FOOT 51

vT VOLT 70

7A LANDINGS 7A

7C FLIGHT HOURS 7C

8C CORD 8C

8D DUTY 8D

8P PROJECT 8P

8R PROGRAM 8R

8s SESSION 8S

K2 SQUARE KILOMETER 8uU

91 STOKE 91

94 CURL UNIT 94

95 20,000 GALLON TANKCAR 95

96 10,000 GALLON TANKCAR 96

97 10 KILOGRAM DRUM 97

98 15 KILOGRAM DRUM 98

WT WATT 99

AP APOTHECARY POUND 9A (X12 VERSION RELEASE 005020

MIGRATION CODE. REFER TO ADC 1008.)
BQ BRIQUET 9B (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

FD FOLD 9F (X12 VERSION RELEASE 005020

MIGRATION CODE. REFER TO ADC 1008.)
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AO APOTHECARY OUNCE 90 (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

PI PILLOW 9P (X12 VERSION RELEASE 005030
MIGRATION CODE. REFER TO ADC 1008.)

ST SEAT 95 (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

9y FAMILY UNIT 9y

us USP UNIT 9Z (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

BA BALL AA

AB BULK PACK AB

AC ACRE AC

YT BYTE AD

G CENTIGRAM AF

Al COP (CYLINDRICAL OR CONICAL MASS) Al

FA FATHOM AK

AL ACCESS LINES AL

AM AMPOULE AM

AR SUPPOSITORY AR

AT ASSORTMENT AS

AV CAPSULE AV

AW POWDER-FILLED VIAL AW

AX TWENTY AX

AY ASSEMBLY AY

BO BRITISH THERMAL UNITS PER CUBIC FOOT BO

BY BUNK B2

B3 BATTING POUND B3

B4 BARREL IMPERIAL B4

B5 BILLET BS

B6 BUN B6

B7 CYCLE B7

B8 BOARD B8

B9 BATT B9

BE BALE BA

BB BASS BOX BB

BC BUCKET BC

BD BUNDLE BD

BM BEAM BE

BF BOARD FOOT BF

BG BAG BG

BH BRUSH BH

BR BAR BI

BJ BAND BJ

BK BOOK BK

BZ BLOCK BL

BO BOLT BM
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BN BULK BN
BT BOTTLE BO
BP 100 BOARD FEET BP
BL BARREL BR
BS BASKET BS
BI BELT BT
BU BUSHEL (32 DRY QUARTS) BU
BV BUSHEL DRY IMPERIAL BV
BW BASE WEIGHT BW
BX BOX BX
zZF MILLION BTUS/DEKATHERM BZ
co CALLS co
c1 COMPOSITE PRODUCT POUNDS (TOTAL WEIGHT) c1
c7 CARSET ()
ca CARLOAD ca
cs cosT 5
c6 CELL 6
cs CUBIC DECIMETER c8
c9 COIL GROUP o
cs CASE CA
cB CARBOY cB
ccC CUBIC CENTIMETER cc
KR KARAT (CARAT) cb
CF CUBIC FOOT CF
cQ CARD cG
co CONTAINER CH
cl CUBIC INCH cl
CE CONE a
CR CONNECTOR CcK
cy CYLINDER cL
™ CENTIMETER ™
CN CAN CN
cp CRATE cpP
cA CARTRIDGE cQ
cz CUBIC METER CR
X CASSETTE cs
cT CARTON cT
cu cupP cu
v COVER cv
HP HUNDRED POUNDS cw
cL colL X
cD CUBIC YARD cyY
c COMBO cz
DA DAY DA
DM DRAM DF
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DG DECIGRAM DG
MI MILE DH
DI DISPENSER DI
DC DECAGRAM DJ
KM KILOMETER DK
DL DECILITER DL
DE DECIMETER DM
DO DOLLARS U.S. DO
DP DOZEN PAIR DP
DQ DATA RECORD DQ
DR DRUM DR
DS DISPLAY DS
DT DRY TON DT
DU DYNE DU
DK DEGREES, KELVIN DV
DX CALENDAR DAYS (NUMBER OF) DW
DY DIRECTORY BOOKS DY
DZ DOZEN DZ
E1 HECTOMETER E1
EA EACH EA
EB ELECTRONIC MAIL BOXES EB
EE EMPLOYEES EE
EH KNOTS EH
E) LOCATIONS E)
EP ELEVEN PACK EP
EQ EQUIVALENT GALLONS EQ
EV ENVELOPES EV
1] INTERNATIONAL UNIT F2
Fa MINIM F4
F6 PRICE PER SHARE F6
DF FAHRENHEIT FA
FB FIELDS FB
FC 1000 CUBIC FEET FC
FE TRACK FOOT FE
FF HUNDRED CUBIC METERS FF
FG TRANSDERMAL PATCH FG
F) SIZING FACTOR FJ
FK FIBER FK
FL FLAKE TON FL
FM MILLION CUBIC FEET FM
FO FLUID OUNCE FO
FT FOOT FT
FU FURLONG FU
GB GALLONS PER MINUTE G2
Gl GILL (IMPERIAL) G5
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GL GALLON GA

GG GREAT GROSS GG

IG IMPERIAL GALLON Gl

GM GRAM GR

GR GROSS GS

GN GRAIN GX

H2 HALF LITER H2

H4 HECTOLITER H4

HK HANK HA

HX HUNDRED BOXES HB

HC HUNDRED COUNT HC

HZ HALF DOZEN HD

HF HUNDRED FEET HF

HG HECTOGRAM HG

HA HUNDRED CUBIC FEET HH

HI HUNDRED SHEETS HI

KH HUNDREDS OF KILOGRAMS HK

HL HUNDRED FEET (LINEAR) HL

HO HUNDRED TROY OUNCES HO

HQ HECTARE HQ

HR HOUR HR

HS HUNDRED SQUARE FEET HS

HT HALF HOUR HT

HD HUNDRED HU
HW HUNDRED WEIGHT — SHORT (HUNDRED WEIGHT) HV

cw HUNDRED WEIGHT (LONG) HW

HB HOSPITAL BEDS HX (X12 VERSION RELEASE 005020

MIGRATION CODE. REFER TO ADC 1008.)

HY HUNDRED YARDS HY

11 PERSONS, CAPACITY

PX PELLET 12 (X212 VERSION RELEASE 005030

MIGRATION CODE. REFER TO ADC 1008.)

PN PERSON IE

H INHALER IH

IM IMPRESSION IM

IN INCH IN

P INSURANCE POLICY IP

IS STOP IS

JB JOoB JA

JU JUMBO B

JOo JOINT JO

JR JAR JR

JG JUG JU

K6 KILOLITER K6

K7 KILOWATT K7
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KV KILOVOLT K8 (X12 VERSION RELEASE 006050
MIGRATION CODE. REFER TO ADC 1008.)
CK CAKE KA
KE KEG KE
KF KILOPACKET KF
KG KILOGRAM KG
Kz KILOWATT-HOUR KH
KK 100 KILOGRAMS KK
KT KIT KT
KU TASK KU
DK KELVIN KV
L5 LITERS AT 15 DEGREES CELSIUS L5 (LOCAL CODE SUBMITTED FOR INCLUSION
IN X12. REFER TO ADC 1108.)
LB POUND (AVOIRDUPOQIS) LB
LE LITE LE
LF LINEAR FOOT LF
LO LONG TON LG
LN LINEAR INCH LI
L LARGE SPRAY L
LK LINK LK
LM LINEAR METER LM
LG LENGTH LN
LT LOT LO
LR LAYER LR
LS LUMP SUM LS
LI LITER LT
LY LINEAR YARD LY
MO MAGNETIC TAPE MO
M3 MAT M3
M5 MICROGRAM MC
MD AIR DRY METRIC TON MD
MG MILLIGRAM ME
M) METRIC GROSS TON MG
MH METRIC Ml
MT MINUTE MJ
ML MILLILITER ML
MM MILLIMETER MM
MA METRIC NET TON MN
MO MONTH MO
M6 METRIC TON MP
MQ 1000 METERS MQ
MR METER MR
MS SQUARE MILLIMETER MS
MK METRIC LONG TON MT
Mz MIXED MX
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N2 NUMBER OF LINES N2

N7 PART N7

N9 CARTRIDGE NEEDLE N9

NB BARGE NB

NC CAR NC

ND NET BARRELS ND

NE NET LITERS NE

NF MESSAGES NF

NG NET GALLONS NG

NI NET IMPERIAL GALLONS NI

NJ NUMBER OF SCREENS NJ

NK NIGHTS NK

NL LOAD NL

NM NAUTICAL MILE NM

NN TRAIN NN

NS SHORT TON NS

NT TRAILER NT

NV VEHICLE NV

NX PARTS PER THOUSAND NX

GT THOUSAND GALLONS PER DAY NZ (X12 VERSION RELEASE 005030
MIGRATION CODE. REFER TO ADC 1008.)

OA PANEL 0A

oL OUTLET OB (X12 VERSION RELEASE 005030
MIGRATION CODE. REFER TO ADC 1008.)

oc BILLBOARD oc

GX APOTHECARY GRAIN 0G (X12 VERSION RELEASE 005030
MIGRATION CODE. REFER TO ADC 1008.)

op TWO PACK oP

ou OPERATING UNIT OU (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

oz OUNCE - AV 0z

PO PAGE - ELECTRONIC PO

P1 PERCENT P1

P2 POUNDS PER FOOT P2

P3 THREE PACK P3

P4 FOUR PACK P4

P5 FIVE PACK P5

P6 SIX PACK P6

P7 SEVEN PACK P7

P8 EIGHT PACK P8

P9 NINE PACK P9

PL PAIL PA

PB PAIR INCHES PB

PC PIECE PC

PD PAD PD

PE POUNDS EQUIVALENT PE

FedMall QSG Catalog Template v1.0.docx

Status: Review
Page 22 of 27



Supplier Catalog Template

PF PALLET (LIFT) PF
PO POUNDS GROSS PG
PH PACK (PAK) PH
PY PITCH PI
PG PACKAGE PK
P) PALLET/UNIT LOAD PL
PS POUNDS NET PN
PM PLATE PP
PR PAIR PR
PT PINT PT
PU MASS POUNDS PU
PV HALF PINT PV
PP PINT IMPERIAL PX
PK PECK DRY US PY
PQ PECK DRY IMPERIAL Pz
ME MEAL Q3
FY FIFTY Q4
TF TWENTY-FIVE Qs
TS THIRTY-SIX Q6
™ TWENTY-FOUR Q7
FV FIVE Q9 (X12 VERSION RELEASE 005030
MIGRATION CODE. REFER TO ADC 1008.)
Qc CHANNEL Qc
Qu QUARTER DOZEN Qp
QE PHOTOGRAPHS QE
QF QUARTER QF **
QK QUARTER KILOGRAM QK
QR QUIRE QR
Qs QUART DRY U.S. Qs
at QUART ar
al QUART IMPERIAL Qu
R4 CALORIE R4
RS THOUSANDS OF DOLLARS RS
R9 THOUSAND CUBIC METERS R9
RR RACK RA
RB RADIAN RB
RC ROD (AREA) - 16.25 SQUARE YARDS RC
RD ROD (LENGTH) - 5.5 YARDS RD
RL REEL RE
RG RING RG
RH RUNNING OR OPERATING HOURS RH
RK ROLL-METRIC MEASURE RK
RO ROLL RL
RM REAM RM
RN REAM-METRIC MEASURE RN
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RE ROUND RO
RP POUNDS PER REAM RP
RS RESETS RS
RT REVENUE TON MILES RT
RU RUN RU
RX THOUSAND ROUNDS RX
S5 SIXTY-FOURTHS OF AN INCH S5
S6 SESSIONS S6
S7 STORAGE UNITS S7
SwW STANDARD ADVERTISING UNIT S8
S9 SLIP SHEET S9
SA SANDWICH SA
M2 SQUARE MILE SB
c2 SQUARE CENTIMETER SC
SN SECTION (640 ACRES OR ONE SQUARE MILE) SE
SF SQUARE FOOT SF
SG SEGMENT SG
SH SHEET SH
Sl SQUARE INCH N
SJ SACK SJ
SR SPLIT TANKTRUCK SK
SV SLEEVE SL
SM SQUARE METER SM
SU SQUARE ROD SN
SL SPOOL SO
S8 SHELF PACKAGE SP
sQ SQUARE sQ
SP STRIP SR
SS SHEET-METRIC MEASURE SS
SE SET ST
SD SKID N
SK SKEIN SW
SB SHIPMENT SX
SY SQUARE YARD SY
Sz SYRINGE SZ
T1 THOUSAND POUNDS GROSS T1
T3 THOUSAND PIECES T3
T4 THOUSAND BAGS T4
T5 THOUSAND CASINGS T5
T6 THOUSAND GALLONS T6
T7 THOUSAND IMPRESSIONS T7
T8 THOUSAND LINEAR INCHES T8
T9 THOUSAND KILOWATT HOURS/MEGAWATT-HOUR T9
TA TENTH CUBIC FOOT TA
TU TUBE B
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TC TRUCK LOAD TC
TG GROSS TON TG
MX THOUSAND TH
Tl THOUSAND SQUARE INCHES Tl
T) THOUSAND SQUARE CENTIMETERS T)
TK TANK TK
MF THOUSAND FEET TL
™ THOUSAND FEET (BOARD) ™
TN NET TON (2,000 POUNDS) TN
TO TROY OUNCE TO
TV TEN-PACK TP
TQ THOUSAND FEET TQ
TR TEN SQUARE FEET TR
TZ THOUSAND SQUARE FEET TS
TL THOUSAND LINEAR METERS TT
™ THOUSAND LINEAR YARDS TU
TH THOUSAND KILOGRAMS TV
™™ THOUSAND SHEETS T™W
TP TROY POUND TX
TY TRAY TY
MC THOUSAND CUBIC FEET TZ
Ul TREATMENT Ul
T TABLET u2
TE TEN u3
us TWO HUNDRED FIFTY us
ue UNITED STATES GALLONS @ 60 DEGREES U6 (MIGRATION CODE APPROVED FOR
FAHRENHEIT VERSION TO BE PUBLISHED JAN 2014. REFER TO
ADC 1008.)
UH TEN THOUSAND YARDS UH
UL UNITLESS UL
UM MILLION UNITS um
UN UNIT UN
upP TROCHE UpP
uQ WAFER uQ
AD APOTHECARY DRAM UX
Vi FLAT V1
V2 POUCH V2
vC FIVE HUNDRED vC
Vi VIAL Vi
'S VISIT VS
w2 WET KILO w2
WB WET POUND wB
WD WORK DAY WD
WE WET TON WE
WG WINE GALLON WG
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WH WHEEL WH

WK WEEK WK

DW PENNYWEIGHT WP

WR WRAP WR

CH CHAIN X1

X2 BUNCH X2

X3 CLOVE X3

X4 DROP X4

X5 HEAD X5

X6 HEART X6

X7 LEAF X7

X8 LOAF X8

X9 PORTION X9

Y1 SLICE Y1

TB TABLESPOON Y2

T2 TEASPOON Y3

Y4 TUB Y4

YD YARD YD

YL 100 LINEAL YARDS YL

YR YEAR YR

1 LIFT VAN Z1

22 CHEST z2

Z3 CASK Z3

HH HOGSHEAD 74

5 LUG Z5

PA PAGE ZP

B2 BARREL, DRY ZW (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

B1 BARREL, LIQUID ZX (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

AS APOTHECARY SCRUPLE ZY (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)
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5 Additional Information: General Text

5.1 Overview

Many fields, outlined in Section 3.2, include the use of “General Text” within their format. The permitted characters vary depending
on the field; however, the majority of acceptable characters to use in General Text are listed below.

5.2 Permitted Characters

Uppercase letters: ABCDEFGHIJKLMNOPQRSTUVWXYZ
Lowercase letters:abcdefghijklmnopqgrstuvwxyz
Numerals:0123456789

Symbols: {space} | "#S5S% & '()*+,-./:;<=>?@[\]_"{}~

5.3 Prohibited Characters

There are a number of characters that seem similar to those listed above but do not qualify as General Text. The following examples
show common misuses of characters:

o  While the hyphen (-) character is permitted the em-dash (—) and en-dash (-) are not.

e  Regular double quotation marks (") must be used rather than special double quotation marks (“). The same rule applies for
single quotation marks, regular (') versus special ().
Note: Microsoft Office autocorrects regular quotation marks to special quotation marks but this can be avoided by pressing
Ctrl+Z (or “undo”) after typing the character. Notepad produces these characters in their correct form.

The following characters are also prohibited:

®  Symbols: caret (*) and pipe (])

®  Symbols greater than DEC 126 on the ASCII table
Note: Users with technical backgrounds are likely to be familiar with the ASCII table. For unfamiliar users, the ASCII table can be
accessed at https://www.ascii-code.com/
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